Instructor’s Notes

Visual Basic - Beginning Intro to Program Development

Visual Basic - Beginning
Intro to Visual Studio 2005

| Notes \ Activity
Text References Read Chapter 2

e Programs Pages 4-6
e Microsoft Visual Studio 2005 Pages 20-26
e Solutions, Projects and Source files Pages 53-54
e Starting a new Project Pages 42 -52
e [DE Pages 26 -32
e Controls Pages 913,47
o 100 — 101
e Forms Pages 42-43
e Labels Pages 44 -47

76 =17
e PictureBoxes Pages 48 -50
e Buttons Pages 64 -65
¢ Code Window Pages 66 — 68
e Help System Pages 80-86

Creating Computer Programs

To create your own programs for a computer, you need a

programming language.

There are dozens (hundreds?)

of programming languages, including COBOL, RPG,
Visual Basic, Java, C++ and C#.
You use the algorithm/pseudocode you developed in the
design phase to convert your logic into the programming
language statements.
Computers can not understand these statements, they

only understand 0’s and 1’s.

The compiler converts the programming language

statements into machine language.

The compiler also informs you if you have broken

any of the rules of the language.

Today, most compilers come packaged with other tools

editors to key in your statements

debuggers to help locate errors in your program

Intro to Program Development--1



Instructor’s Notes Visual Basic - Beginning Intro to Program Development

| Notes | Activity

Procedural versus Object-Oriented Programming

Procedural Programming Languages:
e  Break the logic down into major tasks called procedures.
®  Program determines and controls the order the computer
processes the tasks
e Examples: COBOL, RPG, Procedural C++

Object-Oriented Programming Languages:
¢ Focus is on the objects the program can use to accomplish its
goal/task.
e Objects are treated as independent units.
® Objects can be used in more than one program with little
change.
® Many predefined objects available

Objects

An object is anything you can see, touch or use — a thing.
e Common objects: label, button, checkbox, menu
e Other objects: can represent something in real life — person,
employee, building and a purchase order.

All objects have:
e Attributes/properties — characteristics that describe them
e Behaviors — methods and events
- Methods — action the object can perform
- Events — action that the object responds to such as
clicking a button or when a textbox control changes.

Objects are created from classes. A class is:
e Pattern or blueprint used to create an object.

e All objects of the same class have the same properties and
behaviors of that class.
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About Microsoft Visual Studio 2005

In this class (and Programming Logic - Intermediate), we’ll be using
Microsoft Visual Basic 2005 (which is part of the Visual Studio
software). This software comes with an editor, a compiler, a debugger
and a help system to help you learn the language. These components
together are called the integrated development environment (IDE).

Visual Basic 2005 runs in Microsoft .NET Framework 2.0.
NET framework is
e Platform on which applications are created
Goal is to connect information, people, systems and devices.
Supports VB, C++, C# (C sharp) and J#.
Contains the common IDE
Contains common set of classes shared by the above
languages:
- Prewritten code for Windows components (form,
toolbars, textboxes, etc).
- Common utilities — math utilities, string manipulation.
.NET Framework must be installed on computers that run/use
Visual Studio languages.
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Solutions, Projects and Source Files
e  Visual Studio NET includes the opportunity to combine
many projects into a solution.
- Solutions are containers that can hold many projects.
- Each project could be written in a different language
- Used for large, multi-person system development
- For our purposes, solutions will only have one project
(but that one project must still be included in a solution)
- File extension for the solution is .sin
e All the source files for one program are combined into a
project
- All project files are written in the same language.
- Projects must belong to a solution.
- The project folder is created and stored in the Solution
folder.
- File extension for the project is .vbproj . The project will
be stored in a folder with the same name as the solution.
- Other files are created in the project folder as well.
e  VB.NET programs include many source files.
- Code required to create forms and manipulate the objects
on those forms
- Utility code used by more than one form or more than
one program.
- File extension for the Visual Basic source files is .vbh
e All source files are combined to form a project which is part
of a solution (always).
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Starting Microsoft Visual Studio 2005 Start Visual Basic 2005
To start the process of developing your own program, you’ll first have
to start Microsoft Visual Studio 2005

1. Open the Start Menu, select and click Microsoft Visual Studio
2005.

e Note: there will be slight differences if you are using
Visual Studio 2005 Express versus Visual Studio 2005.

2. Once you have the application running, you will see a tabbed
window - Start Page. The screen will vary from the book and
from the first time and consecutive times you enter the IDE.

e [f you do not have the Start Page, click View menu
option, click Other Windows and then click Start Page.

Intro to Program Development--5



Instructor’s Notes Visual Basic - Beginning Intro to Program Development

| Notes | Activity

Customizing the Visual Studio IDE
e Tools » Options on the menu
e  Option Strict
- Projects and Solutions » VB Defaults
- Forces VB to use strict syntax rules
- Turn on
- Discussed later
e  Default Solution Folder
- Projects and Solutions * General
- Designates the where solutions and folders are stored by
default
- Suggest H: drive or Desktop.
- Pen drives may reduce performance.
» Work on Desktop, copy to pen when done
e Save New Project
- Projects and Solutions * General
- By default, VS doesn’t save new projects until you run or
save manually. Doesn’t even create the folder
- Check Save new projects when created
e Tab Settings
- Text Editor » Basic * Tabs
- By default, VB indents code 4 spaces. Three (3) saves
space.
- Leave Smart Indenting on
e Remove Start Page
- Environment
- Show all settings
- Startup
- Change At startup:
- Constantly closing Start Page gets to be a pain
- Suggest Show empty environment
- If launch project from My Computer, that project will be
loaded
- If launch Visual Studio, can still open projects from the
File menu
- If want to see Start Page use the menu
View » Other Windows » Start Page

e  Setting stick even after you close Visual Studio
- Will need to set these on all computers you use.
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Starting a New Project Create a new project
Each application you create within Visual Studio is called a project .  called Sample

We are now ready to start a new project.
1. Under Recent Projects, click on Project... next to Create. ~ Show Solution, Project
2. In the Project Types pane on the left, ensure Visual Basic ~ and files generated
is selected.
3. Inthe Template pane, select Windows Application.
4. In the Name textbox, you will enter the name of your
project. Do not keep the default of
WindowsApplication].
5. Change the Name to something meaningful to describe the
project. (Note: follow standards/guidelines identified by
the instructor).
6. You can close the Start window if you want by clicking
the X when the Srart tab is selected. Be careful not to
close the entire IDE.
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Locate each Window

Common Windows and features in the IDE
In Solution Explorer:

The IDE contains 5 common windows:
e  Start page — create and open projects, access information on  Select the Show All
how to use Visual Studio 2005, latest news and technical files and View

articles. Code/View Designer
e Solution Explorer — displays the names of projects and files
included in this solution (application). Appears on the top
right portion of the IDE.
- Shows all the projects in the solution (only 1 for our
purposes) and the source files included in the projects
- Windows Form files are designated with this icon
- Code files are designated with this icon ]
- Using the Solution Explorer Toolbar (from left to right)
—  Properties: makes the properties window active
— Show All Files: shows the files generated by Visual
Studio. (We will use this in the next unit)
— Refresh: Refreshes the current project
— View Code: displays the Code window
— View Designer: displays the Design Window for
that active form
e Toolbox — displays objects/controls you can use/add when
creating a project. The toolbox tab appears on the left side of
the screen.
e Properties — displays properties associated with the active
object/control of the form.
e Database Explorer — displays data connections and servers
(will be used in Programming Logic Intermediate)

Other features:
e Menu — provides access to activities you can do within the
IDE.
e Toolbar — buttons under the menu; can be moved, hidden,
displayed and customized.
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Saving the project Save Sample
Save your work often to prevent loss of changes. You can save the
project by:

e Option 1: Select Save All from File menu.

- The Location textbox shows where the project folder will
be created. You can change this by clicking Browse
button and select the drive/folder location.

- The Solution Name will be the folder the project will be
stored in. Keep the Solution and project names the same.

- Then click OK.

e Option 2: Press Ctrl-Shift-S on keyboard and follow above
steps for location and Solution name.

e Option 3: Click Save All button on the toolbar.

e Option 4: Run the program. By default Visual Studio saves
all the project files before running the program.

Closing the project Close Sample
If you did not do a Save All, you will be prompted to Save the
solution. In the Save Project dialog box, complete the following.

1. The Location textbox shows where the project folder will be
created. You can change this by clicking Browse button and
select the drive/folder location.

2. The Solution Name will be the folder the project will be stored
in. Keep the Solution and project names the same. Then click
OK.

If you saved the project earlier but made changes, you will be
prompted to save the project.

Opening Existing Projects Open Sample
You can open an existing project in (at least) 4 ways:
1. Locate the .sIn file using Windows Explorer (My Computer)
and double-click it
2. Open Microsoft Visual Studio 2005. While on the Start Page,
select the project listed in the Recent Projects list. The project
will open (unless it was moved to a different location).
3. Click Open Project... option and locate the project in the Open
Project dialog box. Select the solution file (.sln) and click
Open.
4. Click File in the menu, click Open Project in the file menu
and browse for the project using the Open Project dialog box.
Select the solution file and click Open.
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Managing the IDE Practice closing,
As mentioned above, there are five common windows open in the opening and auto

IDE. More windows can be open depending on what activity you are ~ hiding windows
doing.

e To close an open window, click the Close button

e To open a window, use the View menu

e To auto-hide a window, click the Auto Hide button (looks like

a push pin)

e To display an auto-hidden window, place the mouse pointer

on the window’s tab.

¢ To permanently display an auto-hide window, click the Auto

Hide push pin.

e Typically, do not hide the Solution Explorer and Properties
windows. Hide the Toolbox after you have developed the
form because you will not need this window out as much.

Resize a window

- Move cursor to the edge of the window and the sizing
pointer appears for you to drag the window to the needed
size.

- You can the Properties window (and other windows)
longer by placing the cursor at the top of the window and
dragging the title up. This makes it easier to work with
changing the objects properties.

Windows Form Designer Window Display the properties

You create/design the GUI for the project using the Windows Form of the form in

Designer. alphabetical and then
¢ The form object is the foundation/container for the user category order

interface in Windows applications.

¢ Add objects (controls) from the ToolBox (such as labels,
buttons and textboxes) to the form. The form is an object
itself.

e [f the form is not displaying, double click on the Forml.vb
(or associated name) in the Solution Explorer to display the
designer view.

All objects have properties that describe the object. As you design

your application, you can change the properties using the Properties
Window. The properties can be ordered alphabetically or by category.
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Changing Source File Name Change the name to
A source file is a file that contains program instructions or code. The  frmSample.vb
Form1.vb source file is known as the form file.
¢ (Contains the code associated with the Windows form object or
form.
® Change the default name of the source file from Forml.vb to
something more meaningful. There are two ways possible:
- Click on Form1.vb in the Solution Explorer to get focus.
Click again to be put in edit mode to rename the form.
- Click on the Form1.vb to get focus. In the properties
window, change the Name property.

- REMEMBER: include the .vb extension.

- DO NOT change the solution, project or source file
names directly from Windows. Use the IDE to change
the names. The appropriate directories in the application
will not get updated if you do not go through the IDE.

- Use meaningful names that describe the purpose of the

form. (Ex: WelcomeScreen, EmployeeEntry,
UpdateScreen)

Naming Objects Rename the form to
frmSample

Objects that are referenced in code or by an event, will need to be
named. If the object requires an event procedure or the properties of
the object are changed in code — rename the object from the default
value.

1. Click on the object to select it
2. In the properties window, change the (Name) property.
3. Enter a descriptive name for the object
¢ QOur programming standards dictate all object names
should begin with a prefix.
¢ The name begins with the 3 character prefix in lower case
followed by descriptive name to identify the control. The
first letter of each word of this name is capitalized.
e Examples:
frmSample, 1blName, txtAddress, btnExit, picLogo
e Refer to the class standard prefixes for a complete list.

Note: If an object is NOT referenced in code or by an event, you can
keep the default name.
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Form

Properties
e Text — changes what appears on the form’s title bar
® BackColor — changes the background color of the form
» Note: when form’s background color is changed, the
background color of all objects on the form whose
background color was not set will adapt the background
color of the form.
® Jcon — set the icon that appears in the form’s title bar
e StartPosition - where the form appears on the screen
(normally — CenterScreen)
e Font — set the font (type, size, etc) for all objects on the form
(unless those objects properties are set)
e ForeColor - set the font color for all objects on the form
® BackgroundImage
» Select an image to display on the form’s background.
» Use the backgroundlmageLayout for desired look.
» Note: your project now has a folder called Resources
into which the source image has been copied.

Change these properties
on the Sample form

Text — Class Sample

BackColor — select a
color of choice

Icons: select an icon
from the class folder

Backgroundlmage:
select from class folder

Changing Properties of Controls

As a control is introduced in the notes, the common properties that are
changed for that control are presented. Note: if you change
properties and want to reset them back to the original value, just right-
click on the property and select Reset.

Complete
Checkpoint pg 57
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Add 3 labels — using
Adding Controls each of the 3 methods
mentioned

The toolbox contains the standard tools to add to forms. In OOP
terms, the tools represent a class. When you add an object to the form,
we call them controls.

There are 4 ways to add a control —
e Option 1:
- Double-click a tool in the toolbox
e Option 2:
- Click a tool in the toolbox and drag the pointer to the
form.
- Release the mouse button when the pointer is on the
form.
e Option 3:
- Click the tool and then click the form
e  Option 4:
- Click the tool, then press the mouse pointer on the form
and press the left mouse button to drag the pointer until
the control is the desired size

Manipulating Controls
Once the control is on the form, it can be moved, deleted, sized, select Move labels
multiple controls and aligned multiple controls.
e  Moving Controls Delete a label
- Place mouse over object
- When the pointer changes to a four-headed arrow (move Add the label again

arrow to get it to change), click and drag the object to the
new location. Change the size of each

¢ Deleting Controls label

- Click on the control to gain focus and hit the delete button

- Or, click on the control and select the Cut toolbutton. Select all 3 labels — try

each option

Intro to Program Development--13



Instructor’s Notes

Visual Basic - Beginning

Intro to Program Development

| Notes

| Activity

¢ Sizing Controls

Click on the control to select it.

Place the mouse over one of object sizing handles (the

small white squares around the middle of each edge of the

object).

» Note: Small handles on the corners are used to adjust
both height and width

Drag handles to resize the object.

¢ Select Multiple Controls

Option 1:

» Click on the first control, then Ctrl-Click or Shift-
Click additional objects to select them.

» Ctrl or Shift-Click the object again to deselect it.

» NOTE: the first object selected controls the
alignment (has white handles)

Option 2:

» Point to an empty area near the first object

» Drag a box that encompasses all the objects you want
selected.

» Best used when objects are near each other

Option 3:

» Press Ctrl-A to select all objects on a form

¢ Aligning Controls

When you drag a control to a position on the form, a blue

guide/grid line automatically appears when the controls

are aligned.

Guide line only appears when controls are in line.

Guide can be used to align vertically and horizontally.

Option 2:

» Select controls you want to align

» Click on Format menu option, select Align and select
desired alignment

Option 3:

» With the Layout toolbar showing (to display — select
View / Toolbar / Layout

» Click on toolbar for the type of alignment desired.

Move labels as a group
Deselect labels

Move labels so they are
not aligned

Now — align labels
using the grid

Complete
Checkpoint pg 53
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Labels Add a title to the form
and set it's text

Labels are used to: describe other objects on the form (what should be
entered in this text box?) and display information to the user (such as
output results or directions/remarks that don’t change)
e Add alabel object to the form (see above)
® Labels used to describe other objects or display information  Ngte: same color as
that does not change — ARE NOT renamed (default name form background
used) because code rarely refers to them.
* Labels used to display results will be used in code and should  Change:
have a descriptive name (Ibl prefix). Font

properties
(This program was
written by:)

Properties:
e AutoSize property of a label is set to True by default.

» Makes the label adjust to the size of the Text property  Add another label and
contents. put you’re name in the
» Gives the control a dotted-line rectangle called text. Place under the
bounding box. This marks the tightest rectangle that title label
contains all of the control and you can not manually
change the size of the label.
» To change the size, set the AutoSize to False
Text - controls the words that appear on the label
Image - to add a picture to the label
ImageAlign - control where on the label the image appears
TextAlign - control how the fext aligns on the label (often in
relation to an image location)

e Font - change the appearance of the label's text: font, style Add another label with
and size. the course name by
e ForeColor - change the color of the text on the label copying the first label.

®  BackColor - change the color of the label itself .
> Labels are often transparent so the form's background =~ Add MSTC Logo.gif as

shows through. label image.

> Note: If a background Image was put on the form, the ~Experiment with
label takes on the background color and is not alignment
transparent.

e BorderStyle - set the kind of border the label has around it. Add a border to this
» Labels describing another control don't have a border ~ label
» Labels displaying output - set to FixedSingle

e Visible -indicates if label can be seen on the form

Note: many objects have the same properties (Font, BackColor, Left,

Top, etc). After having been described once in the these notes, they
will not be described again.
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e TIP Experiment with
- If you need many objects that have the same appearance  getting the Font
(e.g. many labels with the same font size) properties for the labels
> Create one object and set it properties appropriately ~ with text to be the
» Copy the object to the clipboard same. Try doing thiw
> Paste a copy of the object onto the form and position ~ with both controls
it appropriately selected.

» Don't forget to rename the copy

- Alternatively, after you’ve finished formatting one object,
press the Ctrl key, point to the object and drag it to a new
location

— A small plus sign should appear next the mouse
pointer to designate you’re adding (copying) a
control

—  The new control will have the same format as the
original but will be assigned a default name.

- You can also place the objects on the form, select them
all and change the properties for all of them at once.

PictureBox Add a PictureBox to the

form
Pictures improve the appearance of the form when used appropriately.

NOTE: The form itself can have a background image but it can not be Set the SizeMode to
resized or repositioned. StretchImage
® Add a PictureBox to the form Assign the bookImage

) to the form
Properties:
- Name - use pic prefix
- Image - designate which image should be displayed
» You can use animated GIFs in picture boxes. If you
want to stop the animation, set Enabled to False
- SizeMode
» Normal: Picture is aligned top-left, as much of the
image as possible displays
» Centerlmage: the image centers itself in the box, as
much of the image as possible displays
» AutoSize: the size of the PictureBox adjusts to
accommodate the entire image
» StretchImage: the image will distort to completely fill
the PictureBox
® Size and position as necessary
e  Commonly modified properties:
Left, Top, Height, Width, BackColor, BorderStyle

Size the PictureBox to
increase the image size

Experiment with size
mode

Experiment with the
visible property
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Buttons Add an OK button to
) ) the form with the Exit
Buttons allow users to designate when program actions should take ‘con and the text OK
place
e Add a button to the form Experiment with text
Properties: alignment

- Name - use btn prefix
- Text - change the words that appear on the button
® Size and position as necessary

e  Commonly modified properties:
Left, Top, Height, Width, Font, ForeColor, BackColor,
Image, ImageAlign, TextAlign

Code Window
Everything you create using VB.NET generates code.

Double-click the form
object to open the code

] ] window
e Alotof code is generated automatically by VB.NET

- Code to create a form
- Code for every object placed on the form

e To view the code for a form, double-click on any object on
the form or on the form itself.

e The event most applicable to the object you double-clicked
will be shown. The code template consists of the Sub
procedure header line and the End (last) line.
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e  Code Features Enter sample code to

- Works a lot like a word processor change the form's
» Cut, copy and paste background color.
» Drag to move or copy (Ctrl-drag)

- Color coding to make code more readable Me.backcolor
» Reserved words in blue (Note auto member list)
» Comments in green (Note color coding)

- Auto-indent
» VB.NET uses the indentation of the previous line to ~ Me.backcolor =
set the indentation of a new line Color.red
» Press Tab to indent further, back space to move to the (Note auto member list)
previous indent
- Auto-End Press enter
» VB.NET automatically inserts End statements for (Note auto indent)
decision and loop constructs (appropriately indented)
- Auto-List Members
» Whenever you refer to an object or a class, VB.NET
shows you the members and methods of that class as
soon as you press a period (.)
» Select the value using the Tab or Spacebar
- Error Highlighting
» Just like when you make a spelling error in MS
Word, VB.NET highlights syntax errors (language
errors) by underlining the erroneous code with a blue
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Adding Code to a Control
Objects know how to handle events, things that users do to the object. ll))t ?113311{6 -click on the

e The most common type of event is the Click event that occurs

) . Add
when a user clicks an object .
. . . . Me.Close with a
® To keep our first application simple, we are going to add
comment

some simple code to our button's Click event
e To add code to an object’s event handler, simply double-click

the object

- The code editor will open in a new tab and VB.NET will
create a procedure (a small section of code) header for the
most commonly accessed event for this object (often the
Click event).

- Type the appropriate VB.NET statements/commands for
this event.
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Switching Views Try it

You will be switching from the Code Editor to the Form Designer
often.
e  Simply click the appropriate tab at the top of the design
window ( [Design] designates form design)
e [If you're in form design, it's often more convenient to simply
double-click an object to get to the Code Editor
®  You can also use the Solution Explorer window. Click the
View Designer button to switch to the Design window. Click
the View Code button to switch to the Code window.

Syntax Rules In the frmSample_Load

Syntax or language syntax, defines the correct way to use a specific event, key in

programming language. Syntax errors occur when you don’t follow
the rules — Visual Basic can’t understand the command you’re trying
to give. If a programmer violates Visual Basic syntax, the application
will not run until it is corrected.

Backcolor
And hit enter

Notice the blue
Most syntax errors are typing errors. squiggly line.
Put cursor on blue line

A nice feature of Visual Studio is it checks for syntax errors as you are
to see error

writing your code. When you move to the next line of code, the
previous line is checked. If there is an error, a blue wavy line appears
under the part of the statement that is in error.
e Position your mouse on the blue squiggly line and an error
message appears.
¢ Fix the error and click off the line to verify the code is correct.

If you do not fix the error and try to run the application, you will not
be able to run the application until the errors are fixed. (Refer to the
Testing/Running section below)

If you do not have syntax errors but your program does not work as

designed, you have logic errors. You need to review the code to
verify you entered the statements correctly.
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Testing / Running a Program
During the project development process, you will want to test your dClLCk the Sit)ar:t
program to make sure it is working as planned. During the testing cbugging button
process, the code you wrote is compiled to make sure the statements .
Click the Stop
follow the rules of the language called syntax rules. .
debugging button

Syntax or language syntax, defines the correct way to use specific
programming language. Syntax errors occur when you don’t follow
the rules — Visual Basic can’t understand the command you’re trying
to give. If a programmer violates Visual Basic syntax, the application
will not run until it is corrected.

Most syntax errors are typing errors. If you do not have syntax errors
but your program does not work as designed, you have logic errors.
You need to review the code to verify you entered the statements
correctly.

To test and run a VB application:
e Click the Start Debugging button on the toolbar * or press
the F5 key
e [f there are remaining errors in your code (referred to as
Build Errors by VB.NET), VB.NET will let you know and
you'll have to fix them before you can run the program.
- An Error List window will display to identify the errors.
- Double click on an error and you will be taken to the
appropriate line of code.
- Evaluate the code and correct the error
e To stop a running program
- close its window by clicking the X in the upper right
corner OR
- click the Stop button ® on the Debug toolbar
» If the Debug toolbar is not visible, right-click any
toolbar and select it from the popup menu
- If the Immediate Window remains visible, close it

Change the code in the
form load to be:

BackColor = red

This will cause a blue
squiggly line

Click the start
debugging — you will
get a message box
indicating there are
errors. Answer no to
see the Error list
window.

Fix errors
Run the program and
then Close it.
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Adding Comments to Code

Comments are descriptions of the project as a whole or code in the
project, added by the programmer, to further describe what the code

does.
0es Complete

Checkpoint pg 70

e To add a comment in VB.NET, type an apostrophe (') and pe 73

followed by the descriptive comment

e The apostrophe can appear anywhere in a line of code
(beginning or middle) but all text after the apostrophe is
ignored.

e  The comments will appear in green

Types of Program Documentation
e Application level — describes the Name of the project,
programmer name, date, purpose and any changes made to the
application.
- For now, enter the general program documentation in the
code for the main form.
- Enter the comments after the Public Class statement
- Use the following general program documentation for all
projects in this course:

Project Name: Sample.vb

Programmer Name: Programming Logic Student

Date: Month day, year

Purpose: Provide a short explanation of the project’s

purpose. You must use complete sentences.

Change Log:
Date of changel — description of change 1
Date of change2 — description of change 2

e Form-level - form level documentation identifies the
procedures (for now — just events) within the form and the
purpose of the procedure.

e Variables and Constants level — for each variable and
constant (described in next unit), provide a purpose for the
variable/constant using inline comments.

® (ode level — for more complex blocks of code, provide
internal documentation describing what the logic does.

Intro to Program Development--21



Instructor’s Notes Visual Basic - Beginning

Intro to Program Development

| Notes

| Activity

Regions Directive
You have the ability to group your code into regions. This features
will collapse and expand code within the region.

Begin with #Region “ identifier-name”
Ends with #End Region

#Region "DataValidation"

Insert code for the Data validation logic he

#End Region

re.

Consider using regions to contain your application and form

documentation

The Final Touch

Hopefully, when you created and customized your form, you assigned
an icon to the form. This icon appears in the form’s title bar and in the
Windwos toolbar when the form is active.

However, there is one more place you need to define an icon—the
project itself. The project icon displays on the executable file of your
program. Each of the project’s forms and the project itself can have
unique icons.

Note: You’ll find your program’s executable file in the Bin, Debug
folder of your project folder.

To add a project icon:

Locate the icon you’d like to use for your project using
Windows or an external icon management program.
o There are lots of icons on the I: drive
Copy the icon to your solution folder
Double-click My Project in the Solution Explorer
Drop down the Icon: list.
Choose the Browse option
Locate your icon
The icon should appear in the My Project window
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Object Oriented terms

This section introduces you to object-oriented terms you will read or
hear about.

® (lass - apatter or blueprint used to create an object.

- Every object used in an object-oriented program comes
from a class.

e [nstance — objects created from a class are referred to as an
instance of the class and said to be “instantiated” from the
class.

- You can have multiple instances of an objects from the
same class in your application. (Ex: you can have 3
labels on your form, you can have 2 buttons on your
form).

- Each object is uniquely referenced by its name.

e FEncapsulation — hiding all the properties (data) and behaviors
(methods and events of an object) in one package. By doing
this the programmer can use the class without having to know
exactly how the class is coded. This is known as information
hiding. (Example: you can drive a car without having to
know how the engine, brakes and exhaust work internally)

® Inheritance — you can create one class from another class.
The new class inherits the attributes and behaviors of the
original class.

e Polymorphism - an object-oriented feature that allows the
same instructions to be carried out differently depending on
the object and the situation. For example: you can open a
door but you can also open your eyes, open a jar or open a
box.
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Help System
) ) ) Complete Using Visual
e  The Visual Studio Help System is a valuable tool. Learn to Basic Help — Tutorial
use it!! 2-17
e Dynamic Help is only available in Visual Studio 2005.
- To display Dynamic Help, select Help menu, then (Note: Visual Basic
Dynamic Help. Express may differ
slightly from Visual
- A new window is displayed providing the following Studio)
Help tools
— HowDol... Complete
— Search Checkpoint pg 87
— Index
—  Contents

e If you are using Visual Basic Express, you access the Help
system through the Help menu and then select from the
above Help tools (listed above).

- The Help system is displayed in a separate Window so
you can move between your application and the Help
information.

Intro to Program Development--24



